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INTRODUCTION
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BASIC COURSE OUTLINE

Day One

I.  CAMEO Introduction (8:30-8:45 am)

II.  Brief History of CAMEO (8:45-9:15 am)

III.  Chemical Information Module (9:15-10:00 am)

IV.  CAMEO Companion Applications, Modules and Menus (10:15-11:00 am)

V.  Basic Navigation Skills (demonstration and hands-on) (11:00-11:30 am)

VI.  CAMEO Tools and Toolbar (demonstration and hands-on) (11:30-11:45 am)

VII.  Basic Data Entry Skills (demonstration and hands-on) (11:45-12:15 pm)

VIII.  Chemical Information Module (demonstration and hands-on) (1:15-2:00 pm)

IX.  Facilities Module (2:00-2:15 pm)

X.  Chemicals in Inventory/Transit Module (demonstration and hands-on) (2:30-3:15 pm)

XI.  Other Modules (3:15-4:30 pm)

Day Two

I.  Refresher (8:30-9:00 am)

II.  Site Plan Viewer (demonstration and hands-on) (9:00-10:00 am)

III.  Hands-on Exercises (10:15-11:00 am)

IV.  CAMEO Query Commands (demonstration and hands-on) (11:00-12:00 pm)

V.  Searching the Chemical Database and Other Modules (1:00-2:00 pm)

VI.  Hands-on Exercises-Query (2:00-2:45 pm)

VII.  Sharing Menu (3:00-3:45 pm)
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Day Three

I.  Refresher (8:30-9:00 am)

II.  Hazards Analysis (9:00-10:00 am)

III.  Hazards Analysis (demonstration and hands-on) (10:15-11:15 am)

IV.  Hands-on Exercises (11:15-12:00 pm)

V.  Advanced Functions in CAMEO (1:00-1:45 pm)

VI.  Workbook (1:45-2:30 pm)

VII.  System Administration (2:45-3:30 pm)

VIII.  Test (3:30-4:30 pm)

IX.  Questions and Answers (4:30-5:00 pm)
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COURSE OF INSTRUCTION

Day One

I.  CAMEO Introduction (8:30-8:45 am)

Trainers and class introduce themselves.  Introduce and explain ‘Little’ vs. ‘Big’ CAMEO.  Class
members will be encouraged to discuss reasons for using CAMEO and to identify specific
problems that CAMEO could be used to address.

Using a series of PowerPoint slides, trainers will explain what each student should be able to
accomplish using ‘little’ CAMEO by the end of the course.  During this opening session, trainers
also will assess class members’ level of awareness/experience with CAMEO as well as
MARPLOTTM and ALOHA .

II.  Brief History of CAMEO (8:45-9:15 am)

Learning objectives:  To ensure that the class understands the needs that CAMEO was designed
to fulfill and the relationship between CAMEO and MARPLOT, CAMEO and ALOHA, and
CAMEO and LandView.

A PowerPoint slideshow will accompany the trainer’s lecture for this session.  Topics to be
covered:

•  Who developed CAMEO and the CAMEO suite of applications
•  Why
•  Relationship between CAMEO, MARPLOT, ALOHA, and LandView

- In development
- In data sharing and compatibility

III.  Chemical Information Module (9:15-10:00 am)

Learning objectives:  To understand more fully what information is contained in the Chemical
Database and from where it originates.

A PowerPoint slideshow will accompany the trainer’s lecture for this session.  Topics to be
covered:

•  Chemical records (“Codebreaker”)
 - Description of chemical
 - Trade names
 - ID numbers
 - Regulatory information
 - Labeling conventions



CAMEO Student Workbook

*** DRAFT - DO NOT CITE OR QUOTE - DRAFT ***
5

•  RIDS
- Description of chemical
- Fire/health hazards
- Recommendations for fire/non-fire response
- Protective clothing for responders
- First aid information

•  Edit/add/remove records
•  How the Database is put together

 - Sources of information
 - Ranking of sources
 - Definition of a chemical

Break (10:00-10:15 am)

IV.  CAMEO Companion Applications, Modules, and Menus (10:15-11:00 am)

Learning objectives:  To introduce students to CAMEO menus and modules.  Students will be
given a broad overview, with explanations, of CAMEO’s architecture and capabilities to add
structure and perspective to their learning process.

A PowerPoint presentation will be used to introduce students to this subject.  Topics to be
covered:

•  Companion Applications
- CAMEO
- MARPLOT
- ALOHA

•  Chemical Information - The Chemical Information module displays the detail records from
CAMEO’s Chemical Database and Response Information Data Sheets (RIDS).

•  Facilities - Within the Facilities module, you can store information on facilities reporting to a
Local Emergency Planning Committee.

•  Chemicals in Inventory/Transit - The Chemicals in Inventory/Transit module maintains a
record of chemical inventories and chemicals in transit at facilities in the community.

•  Storage Locations - The Storage Locations module is a subset of the information in the
Chemical in Inventory/Transit module specifying storage location of chemicals within a
facility.

•  Screening and Scenarios - Within the Screening and Scenarios module, you can perform
hazard analysis on accidental releases of locally stored hazardous chemicals.

•  Toxic Release Inventory - The Toxic Release Inventory module stores information from
annual toxic chemical release reports filed by facilities in the area mandated under Section
313 of SARA.

•  Incidents - The Incidents module stores information on accidental releases of hazardous
substances.
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•  Contacts - The Contacts module maintains a directory of names, telephone numbers of
people or organizations associated with hazardous materials emergency response or planning.

•  Special Locations - The Special Locations module emphasizes locations of high-density,
confined, or sensitive populations for evacuation in emergency situations.

 

•  Resources - The Resources module contains information about groups that may be helpful in
an accident involving hazardous materials.

•  Routes - The Routes module includes information on specific routes used in transport of
hazardous materials.

•  Census Data - The Census Data module is comprised of information collected in the 1990
Census of Population and Housing about people living in all counties of the USA and its
territories.

 
 Menus
•  File - The File option accesses the various modules, manages the printer and exits CAMEO.
•  Edit - The Edit option performs basic editing.
•  View - The View option allows the user to view information in several fashions.
•  Record - The Record option access various detail records and functions in the opened

module.
•  Utilities - The Utilities option accesses system administration functions you may not use

everyday.  These functions include linking chemicals, running a hook, or importing and
exporting data.  These functions are more advanced and will not be explained in this course.

•  Window - The Window option allows you to perform standard Windows manipulation to
better view the information.

•  Help - With the Help option, you can retrieve information about the modules, menus, or
installing CAMEO.

•  Sharing - The Sharing option accesses ALOHA, MARPLOT, and CAMEO’s Site View
Planner.

 
 Site Plan Viewer - CAMEO’s Site Plan Viewer is a tool for organizing pictures of floor plans of
facilities and special locations.  You can also link these floor plans to CAMEO’s Facilities
module to help responders in times of emergency.

V.  Basic Navigation Skills (demonstration and hands-on) (11:00-11:30 pm)

Learning objectives:  To train students in basic skills for navigating CAMEO menus and
modules.  Students also will be introduced to the concept of links and how to use these for
navigating.  In combination, these elements will provide students with a fundamental
understanding of the relationship between CAMEO menus and modules.

The trainer will demonstrate basic skills for navigating CAMEO menus and modules, as well as
use of links for navigating.  Students will follow along, using the application.  Topics to be
covered:

•  Beginning Navigation Skills
- The Browse Window
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- The Detail Window
•  Show Links
•  Relationship between menus and modules

VI. CAMEO Tools and Toolbar (demonstration and hands-on) (11:30-11:45 pm)

Learning objectives:  Having learned about CAMEO’s architecture and how to navigate within it,
students will be introduced to the 18 tools and associated toolbar that accompany CAMEO.
Students will learn how to activate these tools as they work with the trainer through this section.

The trainer will explain and demonstrate CAMEO tools and toolbar functions.  Students will
follow along, using the application.

•  18 CAMEO tools
•  Toolbar, with corresponding icons

VII. Basic Data Entry Skills (demonstration and hands-on) (11:45-12:15 pm)

Learning objectives:  Finally, students will be trained in basic data entry skills for CAMEO.  This
session completes preparatory training for CAMEO — encompassing program history,
architecture, capabilities, and navigation — and ensures a common foundation to support more
sophisticated training during the remainder of the course.
The trainer will demonstrate basic skills for entering data into CAMEO.  Students will follow
along, using the application.  Topics to be covered:

•  Data Entry
- Basic Entry (Add, Edit, Delete)
- Pop up lists
- Scrolling lists
- Shortcuts

•  The Tier II Form

Lunch (12:15-1:15 pm)

VIII.  Chemical Information Module (demonstration and hands-on) (1:15-2:00 pm)

Learning objectives:  To provide students more comprehensive instruction on the kinds of
information stored in the CAMEO Chemical Information module, how the module works, and
how the information can be used and operated upon.  Actual scenarios will be used to illustrate
the importance of accurate interpretation.  Students will learn hands-on how to access and
perform operations on this information.  This session builds upon the morning (preparatory)
lecture on CAMEO modules.
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•  Instructor Demonstrates Use of Database
•  Quick Query
•  Instructor Examples
•  Student Exercises

IX  Facilities Module (2:00 - 2:15 pm)

Learning objectives:  The trainer will discuss the kinds of information stored in CAMEO’s
Facilities module, as well as where to find and access the information.

Break (2:15 - 2:30 pm)

X.  Chemicals in Inventory/Transit Module (demonstration and hands-on) (2:30-3:15 pm)

Learning objectives:  To provide students more comprehensive instruction on the kinds of
information stored in the CAMEO Chemicals in Inventory/Transit module, how the module
works, and how the information can be used and operated upon.  Students will learn hands-on
how to access and perform operations on this information.  This session builds upon the morning
(preparatory) lecture on CAMEO modules.

The trainer will discuss, in greater detail, the kinds of information stored in CAMEO’s
Chemicals in Inventory/Transit module, as well as where to find and access the information.
Students will follow, using the application. The trainer will guide students through examples of
basic operations (e.g., add, edit, remove, search) on the data using skills learned during the
morning session.  Finally, the trainer will guide students through a sample query to illustrate a
practical exercise using this information.  Topics to be covered include:

•  Records - List of chemicals stored at a facility
- Storage amounts
- Storage locations
- Chemical hazards

•  Edit/add/remove records
•  Search
•  Facility query

- List all chemicals stored at a facility

XI.  Other Modules (3:15-4:30 pm)

Learning objectives:  To provide students more comprehensive instruction on the kinds of
information stored in other CAMEO modules, how the modules work, and how the information
can be used and operated upon.  The modules will be covered in various levels of detail.
Students will learn hands-on how to access and perform operations on this information.  This
session builds upon the morning (preparatory) lecture on CAMEO modules.
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The trainer will discuss, in greater detail, the kinds of information contained in other CAMEO
modules, as well as where to find and access the information.  Topics to be covered include:

•  Storage Locations
•  Screening and Scenarios
•  TRI
•  Incidents
•  Contacts
•  Special Locations
•  Resources
•  Routes
•  Census data

Day Two

I. Refresher  (8:30 - 9:00 am)

The trainer will review key concepts taught during the previous day and any issues identified
during the hands-on exercise session at the end of Day One.  The trainer will allow time to
answer any questions that the class may have before proceeding with Day Two agenda.

II. Site Plan Viewer (demonstration and hands-on) (9:00-10:00 am)

Learning objective:  To instruct students on how to link information from Chemical Information,
Facilities, Chemicals in Inventory/Transit, and other CAMEO modules to electronic maps for
viewing.

Based on an existing drawing(s), the trainer will demonstrate how to create links and access and
view a facility site plan using Site Plan Viewer.  Students will follow, using the application.
Topics covered:

•  Creating a site plan drawing
•  Link/Unlink information
•  Link/Unlink symbols
•  Example based on existing drawing

Break (10:00-10:15 am)

III.  Hands-on Exercises (10:15-11:00 am)

Learning objectives:  To “test” the class on their mastery of skills already learned and new
viewing skills, and to allow class members to work together to apply the lessons learned to



CAMEO Student Workbook

*** DRAFT - DO NOT CITE OR QUOTE - DRAFT ***
10

actual, simple problems likely to be encountered.

Class members will work together in small groups (2-4 people) to answer the exercises, which
will be based upon existing case studies compiled by EPA/CEPPO.  One-half hour will be
allowed for the class to go through the exercises (with assistance from the trainer(s), where
necessary), with an additional 15 minutes allowed for discussion of the answers and any
additional questions the class may have.

IV. CAMEO Query Commands (demonstration and hands-on) (11:00-12:00 pm)

Learning objectives:  To show students how to build queries and use query options in CAMEO.
At the end of this session, students will be given an opportunity to browse query commands and
collectively test their comprehension through sample queries.

The trainer will demonstrate how to build queries and use query options in CAMEO while
students follow along on their computers.  Subsequently, the trainer will demonstrate sample
queries.  Significant class participation is expected during this session.  Topics to be covered:

•  Creating a new query
- Query List Manager
- Query Overview
- Selecting query fields
- Specifying conditions

•  Modifying query
•  Running an existing query
•  Output options

- Report
- Database
- Mail merge
- Text file
- Spreadsheet

•  Sample queries

Lunch (12:00-1:00 pm)

V.  Searching the Chemical Database and Other Modules (1:00-2:00 pm)

Learning Objectives:  To access information in each CAMEO module, use a saved query, Access
CAMEO’s Tier II form, and enter data into CAMEO’s Tier II form.

The class will follow along on their computers while the trainer demonstrates.  This session will
be problem-oriented, with significant class participation expected.  Topics to be covered:
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•  Review basic navigation skills
- The Browse Windows
- The File menu item
- The Set Filter menu item

•  The Query menu item
- Query rules
- Working with a saved Query
- Setting up a new query #1

•  Chemical Inventory for Chlorine
- Setting up a new query #2

•  Upcoming CAMEO Today
•  Inherent Problem in Query (User Fields)

- Setting up a new query #3
•  The Tier II Form

- Background
- Viewing
- Adding information

•  Tier II Form data in CAMEO

VI.  Hands-on Exercises - Query (2:00-2:45 pm)

Learning objectives:  To give the class an opportunity to test their comprehension of query skills,
and to allow class members to work together to apply the lessons learned to actual, simple
problems likely to be encountered.

Class members will work together in small groups (2-4 people) to answer the exercises, which
will be based upon existing case studies compiled by EPA/CEPPO.  One-half hour will be
allowed for the class to go through the exercises (with assistance from the trainer(s), where
necessary), with an additional 15 minutes allowed for discussion of the answers and any
additional questions the class may have.

Break (2:45-3:00 pm)

VII.  Sharing Menu (3:00-3:45 pm)

Learning objectives:  To ensure that the class understands how CAMEO can be used to interact
with other software applications in the CAMEO suite.  The purpose of this demonstration is not
to show the class how to perform a wide variety of steps in CAMEO but rather to ensure that
they understand the capabilities of the CAMEO sharing menu and its interaction with
MARPLOT and ALOHA (with an emphasis on MARPLOT).  Interactions with LandView and
Site Plan Viewer also may be discussed.

Students will follow along at their computers, while the trainer demonstrates the subject matter.
Topics to be covered:
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•  Linking with MARPLOT (via Census layer)
•  Linking with ALOHA
•  Other

Day Three

I. Refresher (8:30-9:00 am)

The trainer will review key concepts taught during the previous day(s) and any issues identified
during Day One and/or Two.  The trainer will allow time to answer any questions that the class
may have before proceeding with Day Three agenda.

II.  Hazards Analysis (9:00-10:00 am)

Learning Objectives:  To explain legislative background.  To explain the purpose and benefits of
hazards analysis and identify the steps in conducting a hazards analysis.  Students will
understand the difference between the initial evaluation phase and the re-evaluation phase of the
hazards analysis.

Students will follow along at their computers, while the trainer demonstrates the subject matter.
Topics to be covered:

•  Questions responders and planners encounter
- Which hazards should be addressed first?
- Are existing emergency plans adequate?
- Are the response capabilities adequate?

•  Introduction to Legislative Background
•  Identifying and setting hazard priorities

- Identification methods
- Prioritization factors

•  The hazards analysis process
- Why hazards analysis
- Hazards identification
- Vulnerability analysis
- Risk analysis

•  The initial evaluation
- Worst case assumptions
- Establishing priorities

•  The re-evaluation
- Credible worst case assumptions
- Risk ranking

Break (10:00-10:15 am)
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III.  Hazards Analysis and CAMEO (demonstration and hands-on) (10:15-11:15 am)

Learning Objectives:  To review the chemical database inputs to hazards analysis, understand
how to perform a screening and scenario calculation and plot out the output using MARPLOT

Students will follow along at their computers, while the trainer demonstrates the subject matter.
Topics to be covered:

•  Chemical database
- Where information is located
- What information is available
- How to modify or add to the data

•  Screening and Scenarios module
- What is the difference between screening and scenario
- Creating new records
- Selecting chemicals
- Reviewing stack components

•  Calculations
- Credible worst case accident
- Evaluation of other scenarios
- How is this different from ALOHA

•  Plotting
- Linking to map location
- Locked map layer
- Deleting/Hiding plumes

•  So now what do I do...

Lunch (12:00-1:00 pm)

IV.  Advanced Functions in CAMEO (1:00-1:45 pm)

Learning objectives:  To show the class more advanced functions available in CAMEO. These
functions include developing and printing reports and navigating in CAMEO using the Windows
menu.

Break (1:45-2:00 pm)

V.  System Administration (2:00-3:00 pm)
Learning Objectives:  To introduce students to basic system administration and management
concepts and understand the importance of good system management, how to list and describe
the seven elements of good system management, and the seven elements as they apply to specific
pieces of CAMEO.
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A PowerPoint slideshow will accompany the trainer’s lecture for this session.  Topics to be
covered

•  The seven (eight) elements of good system administration
- Planning
- Building
- Using
- Managing
- Maintaining
- Training
- Reviewing
- Researching

•  Relating the seven elements to specific pieces of CAMEO
- Hardware and software requirements

Looking to the future
- Using MARPLOT and CAMEO
- Administration functions

•  Evaluating use

VI.  Test (3:00-4:30 pm)

Learning objectives:  To give the class the opportunity to test themselves on their comprehension
of both the more advanced CAMEO skills and the basic skills learned Day One and Two.

Class members will work together in small groups (2-4 people) to answer the exercises, which
will be based on those provided by EPA/CEPPO.  Forty-five minutes will be allowed for the
class to complete the exercises (with assistance from trainer(s), where necessary), with an
additional fifteen minutes allowed for discussion of the answers and any additional questions the
class may have.

IX. Questions and Answers (4:30-5:00 pm)

A final opportunity for students to ask any questions about the material covered or about
potential problems or applications of CAMEO.
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QUICK REFERENCE

CAMEO Toolbar

•First Detail Record

•Previous Detail Record

•Next Detail Record

•Last Detail Record

CAMEO Toolbar (cont.)

•Add

•Edit 

•Delete

•Find

•Browse
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CAMEO Toolbar (cont.)

•Query

•Find All

•Save

•Cancel Changes

•Close

CAMEO Toolbar (cont.)

•Site Plan Viewer

•MARPLOT

•ALOHA

•RIDS

•Help
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SOME COURSE MATERIALS

CAMEO® 3-Day
Training Course

Computer-Aided Management of
Emergency Operations

Course Overview

● Learn basic concepts and functions of
the CAMEO system

● Provide demonstration of query
commands and overview of CAMEO’s
interaction with other programs

● Learn how to perform a hazards
analysis and cover some advanced
concepts
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Objectives

● At the end of the CAMEO introductory
course, you should be able to:
» Comfortably maneuver around CAMEO

» Use the chemical database and be familiar
with CAMEO’s modules

» Perform a hazards analysis

» Understand relationship between CAMEO
and other software applications

What is CAMEO?

● CAMEO is computer software primarily
used:
» For chemical emergency planning

» For chemical response; and

» For regulatory compliance (e.g., SARA
Title III (EPCRA), OPA 90, RCRA)
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CAMEO Components

● The overall CAMEO system is a suite of
three separate, integrated software
applications:
» CAMEO

» MARPLOT™

» ALOHA®

CAMEO Answers Questions

● What hazards are at this site?

● Where is the hazard located?

● What is the chemical?

● What specific hazard(s) does it
present?

● How can the hazard be mitigated?
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Brief History of
CAMEO’s Development

Who developed CAMEO?

● Developed by:
» EPA’s Chemical Emergency Preparedness

and Prevention Office

» NOAA’s Hazardous Materials Response
and Assessment Division

● In collaboration with
» U.S. Department of Commerce’s Bureau of

the Census

» U.S. Coast Guard
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CAMEO was developed for:

● SERCs, TERCs, and LEPCs

● Emergency responders

● Emergency planners

● Chemical facilities

Major Uses of CAMEO

For
Emergency

Planning

For
Emergency
Responses

For Support
of LEPC

For Managing
Facility

Chemical
Inventory

0%

10%
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80%
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For
Emergency
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of LEPC
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Facility

Chemical
Inventory
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Type of Organization Using
CAMEO

Fire 
Department

48%

Chemical 
Facility

6%

Other 
Organizations

14%Emergency 
Planning/
Response

32%

Fire Department

Emergency
Planning/Response
Chemical Facility

Other Organizations

Navigating CAMEO
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STUDENT PROBLEM SETS

Problem Set 1
 

1. What chemical is also known as dichloromethane (a commonly used synonym)?
 

2. If you are searching for a chemical and the only information you have is the following UN
number, 1701, where should you begin?

 

3. What is the common name of this chemical?
 

4. How many chemicals in the database require the DOT label, "Spontaneously Combustible"?
 

5. What is the "Flash Point" for ethylene glycol?
 

6. What would be the most appropriate protective clothing to wear when responding to a release
of sulfuric acid?

 

7. How many facilities are located in Haymarket?
 

8. What facility is listed as having Toxic Release information?
 

9. How many chemicals start with the letter "S" and are Extremely Hazardous Substances?
 

10. Looking at the list from the previous question, can you find out what the DOT label for
sodium selenite says?

Data Entry Exercise

In this exercise you will update the Facility Contact information for the Green Valley Water
Facility.  Imagine that you are an LEPC and you have received a telephone call from the Human
Resources department at the Green Valley Water Facility.  Green Valley has a new Senior Plant
Manager and they wanted to make sure that you had the most current contact information.  You
need to include this new information in your records for the Green Valley Facility.  You have
been given the following information:

Name:   Wong, Angela
Organization:  Green Valley Water Facility
Title:   Senior Plant Manager
Work Phone:   (703) 232-5547
Beeper:   (703) 232-7554
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You receive a call from Angela Wong, she reports that Green Valley just received a new
shipment of chlorine.  You need to update your records for the Chemicals in Inventory at the
Green Valley Facility.  You have been given the following information:

Chemical: Chlorine
Amount: (5) 150# cylinders
Storage Location: Water House
Other: Pure, gas, greater than ambient pressure, reactive, acute, normal ambient

temperature
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Problem Set 2

1. How many chemicals begin with the formula C6H6 and are not listed as an EHS?1  The Quick
Chemical and the Query menu items can be used to answer the question.  However, please
use the Quick Chemicals menu item in the View Menu and write down the number of
chemicals found in the search.

2. To highlight the differences with the Quick Chemicals menu item and the Query menu item,
please answer the previous question using a query.  Note:  Make sure to clear the subset of
information you have filtered using Quick Chemicals, but do not clear the query once you
have finished with this question.

3. Comparing searches done using both the Quick Chemicals menu item and the Query menu
item demonstrate significant differences in results.  The difference in results can be attributed
to the inclusion of synonyms.  The Query menu item includes synonyms for the filtered
chemical unlike the Quick Chemical menu item.  Therefore, how many different chemicals
are there when closely examining the query results in Question 3?  Hint: You may want to
edit the Record Filter in the Query Overview dialog box to obtain the preferred name for each
chemical.

4. In this exercise you will manipulate the chemical database to determine the appropriate
emergency information.  Imagine that you are an LEPC and have received a telephone call
from a local firefighter.  An accident occurred in which a truck spilled an unknown chemical.
Fortunately the first responder was able to determine from a torn label that the CAS Number
ended in “00-0” and the chemical name contained the letters “mal.”  What is the chemical
and the appropriate first aid if a victim contacts the chemical.

                                                
1 Chemicals that are not listed as Extremely Hazardous Substances are distinguished by an “F” for false.
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Problem Set 3

1.  You are dispatched to a traffic accident involving 2 trucks that is reported without injury.
You have been dispatched for hazard control only.
 

 As you arrive, you find a home heating oil tanker with a 8 gallon per minute leak and a tractor
pulling a 40' box trailer with "Overnight" in large blue and white letters painted on 3 sides.
There are about 30 bystanders milling about the wreckage and a schoolyard full of children
across the street on recess.
 

 The box trailer has split open and approximately 100 red, white, and blue cardboard drums have
spilled out with 12 of the drums damaged and split open.  There is a dry, white powder scattered
over about a 300 square foot area.  The name printed on the box is "Solvox".
 

 Identify the substance and determine the course of action you will take.
 

2.  You are dispatched to a 4 story laboratory complex that employs approximately 500 persons,
for an undefined type of "spill".

The temperature is 68 degrees, winds are light and variable and it is a sunny day with few clouds
in the sky.

On arrival, you are met by one of the lab techs who leads you to a second floor lab where a 1
gallon container has been knocked from a lab bench.  The lab tech cannot identify the material in
the bottle as it his first day on the job.

Your recon crew reports that 1 gallon of an unknown liquid is on the floor along with a quantity
of a yellow crystalline material.  The label on the container contains the following information:
"Melnite CL 10305".  There is a red and white sticker on the bottle, but because of the damage, it
is not readable.

The lab hood is operating and the liquid substance appears to be evaporating.

Identify the substance and determine the course of action you will take.

3.  You are on a "fire prevention detail" in the area of the Maryland Gate Picnic Area and hear a
horrendous grinding noise and crash.  You observe a large cloud of dust and dirt in the vicinity of
the railroad tracks.  You go to investigate and find that a freight train has derailed.  There is no
fire.

You radio the situation into Aberdeen Control and the dispatcher sends an Engine along with the
duty Assistant Chief.
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When your units arrive, you go toward the area of the train's engine and meet the crew, visibly
shaken and injured.  The engineer hands you the trains consist and falls unconscious.  You call
for medical assistance - it arrives - and you begin to survey the damaged rail cars for any hazards.

During your inspection, you find a tank car with a leak caused by the coupler of another rail car
that has punctured it.  The number "NATX 4906225" is stenciled on the side of the rail car.

You check the railroad consist, and all that you can find is a single number associated with that
particular rail car.  It is:  "MU7175000".

Identify the substance and determine the course of action you will take.
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ANSWERS TO STUDENT PROBLEM SETS

Answers to Problem Set 1

1. Answer:  methylene chloride
 

2. Answer:  Search for the number in the UN# field.
 

3. Answer:  vinyl chloride
 

4. Answer:  46 chemicals in the database require the DOT label, "Spontaneously Combustible."
 

5. Answer:  232 degrees Fahrenheit.
 

6. Answer:  For emergency situations, wear a positive pressure, pressure-demand, full facepiece
self-contained breathing apparatus (SCBA) or pressure-demand supplied air respirator with
escape SCBA and a fully-encapsulating chemical resistant suit.

 

7. Answer:  3 facilities are located in Haymarket.
 

8. Answer:  Green Valley Water Facility.
 

9. Answer:  27
 

10. Answer:  Poison

Data Entry Exercise

Answer:  N/A
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Instructions and answers to Problem Set 2

1. Answer:  18

Steps to follow:
a) Access the Chemical Information browse window.
b) Go to the View menu and click on Quick Chemicals.
c) In the field for Formula and EHS, type, “C6H6” and “N,” respectively.
d) Click on the Run button to begin the search.
e) In the lower left-hand corner of the screen, CAMEO provides the number of records queried.
f) To exit the Quick Chemicals Filter, click on Clear Quick Chemicals in the View Menu.

2. Answer:  541

Steps to follow:
a) Access the Chemical Information browse window.
b) Go to the View menu and click on Query.
c) Because no previous queries will answer this question, you will need to create a new query.
d) Click the Add button in the Query List Manager.  Once you have given your new query a

name, you will be asked to complete a number of steps.
e) In Step 1, pick a field by locating Formula and pressing Enter.
f) In Step 2, pick “Begins with or matches” as the pick operator and press Enter.
g) In Step 3, enter the comparison value as “C6H6” and click on OK.
h) Again click on OK to exit and save changes.
i) You will now have to add another condition to obtain only the chemicals with a formula of

C6H6 and a false EHS determination.  Click on Add in the Filter Building dialog box.
j) You will be asked to select a connector.  Click on And to specify that both this condition and

the prior condition must be true.
k) Repeat Step 1 accordingly by clicking on EHS Chemical.
l) In Step 2, pick “Is false” as the pick operator and press Enter.
m) Once satisfied with your query, click on OK to exit and save changes.
n) Again click on OK in the Filter Building dialog box to return to the Query List Manager.
o) To access the query, click Select in the Query List Manager.
p) Click OK on the instruction window to proceed to the Select Fields To Show In Query dialog

box.
q) Query Maker will present the Select Fields To Show In Query dialog box.  For this example,

select Chemical Name, CAS #, Formula, and EHS Chemical.  Press OK at the bottom of the
window to proceed to the Query Overview dialog box.

r) If satisfied with the record filter, click Run Query.
s) In the lower left-hand corner of the screen, CAMEO provides the number of records queried.
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3. Answer: 18

Steps to follow:
a) It can be determined that there are only 18 actual chemicals within the subset by scrolling

down the filtered list of chemicals and counting the number of different CAS Numbers.
b) Alternatively, press Escape on your keyboard to proceed to the Output Query? window.
c) Because you do not wish to continue the query after having viewed the results, click No to

return to the Query Overview dialog box.
d) To condense the previous query to include only the preferred name for each chemical, click

Edit Record Filter to proceed to the Filter Building dialog box.
e) Highlight the condition that states, “EHS Chemical is false” and click Add.
f) You will be asked to select a connector.  Click on And to specify that both this condition and

the prior condition must be true.
g) You will have to add another condition to obtain only the chemicals with a preferred name of

“C6H6” and a false EHS determination.
h) In Step 1, pick a field by locating “Is Chemical Preferred?” and pressing Enter.
i) In Step 2, pick “Is true” as the pick operator and press Enter.
j) Click on OK to exit and save changes.
k) Again click on OK in the Filter Building dialog box to return to the Query Overview dialog

box.
l) If satisfied with the record filter, click Run Query.
m) In the lower left-hand corner of the screen, CAMEO provides the number of records queried.
n) To exit the Query Filter, click on Clear Query in the View Menu.

4. Answer:  Formaldehyde.  A responder should move any victim to fresh air and call
emergency medical care.  If a victim contacts the chemical on their clothing, the
contaminated clothing and shoes should be removed and isolated; whereas points of contact
with the body should be immediately flushed with running water for at least 15 minutes.

Steps to follow:
a) Access the Chemical Information browse window
b) Go to the View menu and click on Query.
c) Because no previous queries could answer this question, you will need to create a new query.
d) Click the Add button in the Query List Manager.  Once you have given your new query a

name, you will be asked to complete a number of steps.
e) In Step 1, pick a field by locating CAS # and pressing Enter.
f) In Step 2, pick “Ends with” as the pick operator and press Enter.
g) In Step 3, enter the comparison value as “00-0” and click on OK.
h) Again click on OK to exit and save changes.
i) You will have to add a condition to obtain only the chemicals with a CAS Number of “00-0.”

Click on Add in the Filter Building dialog box.
j) You will be asked to select a connector.  Click on And to specify that both this condition and

the prior condition must be true.
k) In Step 1, pick a field by locating CAS # and pressing Enter.
l) In Step 2, pick “Is not an empty field” as the pick operator and press Enter.
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m) Click on OK to exit and save changes.
n) You will have to add another condition to obtain only the chemicals with a CAS Number of

“00-0” and a chemical name that contains “mal.”  Click on Add in the Filter Building
dialog box.

o) You will again be asked to select a connector.  Click on And to specify that this condition and
the two previous conditions must be true.

p) In Step 1, pick a field by locating chemical name and clicking Enter.
q) In Step 2, pick “Contains text” as the pick operator and press Enter.
r) In Step 3, enter the comparison value as “mal” and click on OK.
s) Click on OK to exit and save changes.
t) Again click on OK to return to the Query List Manager.
u) Highlight the appropriate query and click Select in the Query List Manager.
v) Click OK on the instruction window to proceed to the Select Fields To Show In Query dialog

box.
w) Query Maker will present the Select Fields To Show In Query dialog box.  For this example,

select Chemical Name, CAS #, Ambient State, NFPA Fire, NFPA Hazard, and NFPA
Reactive.  Press OK at the bottom of the window to proceed to the Query Overview dialog
box.

x) If satisfied with the record filter, click Run Query.
y) Once CAMEO has finished searching, click on the first record for “Formaldehyde” to enter

the detailed chemical information window.
z) Click on the RIDS button to view the Response Information Data Sheet for formaldehyde.
aa) Click on the button for First Aid to obtain the appropriate information.


